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1 PART 1: TRAINING A PANEL IN SENSORY 
ANALYSIS AND IMPLEMENTING DESCRIPTIVE 
TESTS. 

Aim: Setting Up and Managing a Sensory Analysis 
Tasting Panel 

1.1 Pre-selection / Recruitment 
The aim of this section is to describe the initial selection process for recruiting an individual onto 
the tasting panel to establish a sensory profile in sensory analysis. 

1.1.1 Control elements 

A sensory analysis panel is a veritable "measuring device". As such, the results of the analyses 
depend on the quality of the panel’s members. Recruiting people who are willing to take part on a 
panel must be handled with care. 

A preliminary selection of candidates should be held during the recruitment phase to eliminate 
individuals who might be ill-suited to sensory analysis. 

Panellists are recruited on a voluntary basis via a straightforward application or internally following 
a call from the laboratory, meaning they do not need to be paid. Care should be taken during 
recruitment to ensure there is an equal balance between men and women as well as good age 
distribution among the potential panellists (from 18 to 60 years). 

The number of people to be recruited varies. For statistically correct results, there needs to be a 
minimum of eight panel members. It is highly desirable, however, for the panel to consist of at least 
10 subjects who are qualified to carry out the test. It is necessary, therefore, to recruit and train 
between at least 12 and 15 people. In general terms, if you want the panel to consist of X subjects, 
it is advisable to recruit and train around 1.5X people.  

1.1.2 Procedure 

A questionnaire should be completed by anyone wishing to join the tasting panel (see Appendix 1: 
Pre-Selection Questionnaire for Tasting Panellists). The aim of this questionnaire is to obtain 
general information and to control the availability, interest and motivation of potential recruits. The 
information provided is processed under strictly confidential conditions in line with the relevant 
recommendations. 

- Personal data 

The personal data of interested individuals is rated in order to obtain an overview of the panel 
(distribution of sex, age, etc.) and to check the feasibility of integrating potential members into the 
panel (geographical location, etc.). 

Accordingly, the questionnaire asks for the following details: surname and first name, e-mail 
address and telephone number, sex, age group, nationality and occupation. 
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- Availability 

Future panellists must be available for training and subsequent assessments.  

Individuals who do not live in the same town as the sensory analysis laboratory are not selected for 
practical reasons. 

People who are available for at least three days a week, and who do not travel on a regular basis, 
should be selected. 

- Eating habits 

It is important to know whether candidates are averse to any of the food products that may be 
offered as part of an assessment for cultural or other reasons, meaning they cannot eat certain 
products. 

In the questionnaire, we ask people what foods they do not wish to consume. 

- Health 

We ask candidates to tell us if they have any food allergies so we can avoid offering items they are 
allergic to. 

Candidates will be informed about the outcomes based on the above criteria: 

- Either they will be pre-selected and may be called to attend the general training phase; 

- Or they are not pre-selected, in which case they may retake the pre-selection tests in the future if 
their conditions change. 

1.2 General Training 
New panellists must first follow the introductory and general training phase described in this 
section. 

Each panellist must subsequently attend the mandatory annual training and various one-off training 
sessions set up by the sensory analysis team.  

1.2.1 General introduction to the laboratory and tasting 
methodology 

Introduction 

The role of sensory analysis within the company must be explained at the first training session as a 
way to involve and motivate future subjects on the tasting panel. 

A visit will be made to the premises with more detailed explanations about the tasting room and the 
procedures followed during sessions. 

At this first session, the subjects are also introduced to the analysis and basic notions of sensory 
physiology. It is important to explain the role of the various sense organs and the nature of the 
sensory traits to which they are sensitive. 
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The first session will also be an opportunity to explain the general tasting instructions and 
recruitment process to candidates if their results on the various tests are positive (the terms of 
appointment, signatures needed, etc.). It is also used to set out the overall approach to monitoring 
the panellists (selection, training, validation, tests, etc.), the types of tests and the frequency of the 
sessions. 

All these points will be addressed during a general introduction using a PowerPoint slideshow 
based on the presentation given during the training in Uganda (available online). This sets out the 
following:  

 - An overview of the laboratory and its activities 
 - The role and importance of sensory analysis 
 - Different types of sensory tests 
 - The panel 
 - Tasting methods 

Retro-olfaction demonstration 

Before the first tests, it is important to use a short exercise to show the panellists the distinction 
between smell, flavour and aroma and to clearly define them; and to explain the phenomena that 
occur during the olfaction process and tasting. 

This retro-olfaction test demonstrates that the perception of a flavour in the mouth is a multimodal 
sensation. It consists of a set of taste, olfactory and trigeminal sensations (all the thermal, tactile 
and pain sensations). 

It is important to underline and explain how air moves via the retro nasal passage (by the channels 
between the mouth and the nose, called choanae). The aromatic molecules are transported in this 
passage to the olfactory mucosa. 

This test must be carried using a reasonably aromatic product (e.g. Tagada® strawberries or other 
sweets with a high aromatic intensity). 

Give a sweet to everyone and explain the test process: 

- Block the nose 
- Place the product in the mouth and close the mouth 
- Chew the product without opening the mouth 
- Release the nostrils and take a breath of air through the mouth to assess the difference in 
perception 

1.2.2 Performing sensory tests to select and train the panel 

Six trials are set up to finalise the selection of panellists and train them. 

These trials help candidates become accustomed to the methods and materials used in sensory 
analysis; to identify a shortcoming; and to assess a candidate’s potential.  

Basic flavour and sensation recognition test  

An initial test to identify flavours and sensations is performed in order to determine the sensitivity of 
the candidates.  

The aim of the test is to introduce subjects to the basic flavours – acidic, bitter, salty, sweet – and 
the sensation of astringency, and to assess their sensitivity. 
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The trainer will explain the difference between flavours and sensations, introducing the idea of 
astringency, an essential sensation in various matrices.  

- Preparation protocol 

See Appendix 2: Standard Solution Preparation Protocol for Flavour and Sensation Tests. 

Prepare a 1.5 L solution (called a "stock solution" = Ss) of each basic flavour – acidic, bitter, salty 
and sweet – together with an astringent solution using the most neutral and most stable water 
possible: 

Acidic = tartaric acid at a concentration of 3 g/L (i.e. 4.5 g in 1.5 L of water). 

Bitter = quinine at a concentration of 0.06 g/L (i.e. 0.09 g in 1.5 L of water). 

Salty = anhydrous sodium chloride at a concentration of 7.5 g/L (i.e. 11.25 g in 1.5 L of water). 

Sweet = sucrose at a concentration of 60 g/L (i.e. 90 g in 1.5 L of water), 

Astringent solution = potassium aluminium sulphate dodecahydrate at a concentration of 5 g/L 
(i.e. 7.5 g in 1.5 L of water). 

Prepare the D7 dilution according to Table 1 below based on these solutions: 

TABLE 1: PREPARATION OF DILUTIONS 

Solution Acidic Bitter Salty Sweet Astringent  

  Ss / 
1.5 L g/L Ss / 1.5 

L g/L Ss / 1.5 
L g/L Ss / 1.5 

L g/L Ss / 
1.5 L g/L 

D1 63 mL 0.13 25 mL 0.0010 33 mL 0.16 33 mL 1.32 33 mL 0.11 

D2 79 mL 0.16 35 mL 0.0014 47 mL 0.24 47 mL 1.88 47 mL 0.16 

D3 98 mL 0.20 50 mL 0.0020 67 mL 0.34 67 mL 2.69 67 mL 0.23 

D4 123 mL 0.25 72 mL 0.0029 96 mL 0.48 96 mL 3.84 96 mL 0.32 

D5 154 mL 0.31 103 mL 0.0041 137 mL 0.69 137 mL 5.49 137 mL 0.46 

D6 192 mL 0.38 147 mL 0.0059 196 mL 0.98 196 mL 7.84 196 mL 0.66 

D7 240 mL 0.48 210 mL 0.0084 280 mL 1.40 280 mL 11.2 280 mL 0.94 

D8 300 mL 0.60 300 mL 0.0120 400 mL 2.00 400 mL 16.0 400 mL 1.34 
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- Implementing the test 

Prepare 12 glasses numbered 1 to 12 for each subject. 

Serve two glasses of the D7 dilutions of each flavour and astringent sensation and two glasses of 
water in the order shown in Table 2. 

TABLE 2: SERVING ORDER FOR RECOGNISING FLAVOURS AND SENSATIONS 

Glass 1 2 3 4 5 6 7 8 9 10 11 12 

Response Bitter Water  Sweet Astringent Acidic Salty Water  Acidic   Salty Astringent  Sweet Bitter  

- Instructions 

The subjects must taste the solutions in the order they are presented in, and may backtrack. They 
must ascertain the flavours and sensations in each glass and identify the glasses of water. 

Each panellist must indicate his or her results on the Identification of Basic Flavours and 
Sensations form (see Appendix 3). 

When all the panellists have completed the test, the facilitator undertakes a common correction. 

Basic flavours classification test 

The aim of this test is to train subjects in how to use an intensity scale by working on dilutions of 
salty and sweet flavours.  

- Preparation protocol 

Using the stock solutions that you prepared previously (Table 1), prepare a series of dilutions D1 to 
D6 of salty and sweet flavours. 

- Implementing the test 

For each subject, prepare six glasses from A to F for each series  

Series 1: A1, B1, C1, D1, E1, F1 salty 

Series 2: A2, B2, C2, D2, E2, F2 sweet 

Serve the glasses in the order indicated in Table 3 below (one line per series): 

TABLE 3: SERVING ORDER FOR FLAVOUR CLASSIFICATION TESTS 
Series 1:                
Glass A1 B1 C1 D1 E1 F1   
Order (dilution)  D2 D3 D1 D5 D6 D4   
Response Salty   
  

Series 2:               

 

Glass A2 B2 C2 D2 E2 F2   
Order (dilution) D1 D5 D4 D3 D2 D6   
Response Sweet   
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- Instructions 

The subject should classify the glasses for each series in ascending order of concentration and 
determine which flavour has been presented. 

It is advisable to start by separating the three most concentrated solutions and then classify each 
of the groups separately before comparing the last of the least concentrated group with the first of 
the most concentrated. 

Each panellist should indicate his or her results on the Classification test form (see Appendix 4). 

When all the panellists have taken the test, the facilitator performs a common correction. 

Threshold test for perception of basic flavours and sensations 

The aims of this test are to determine each panellist’s personal perception threshold for basic 
acidic and bitter flavours and astringency; to assess their sensitivity; and to train them in how to 
use an intensity scale. The test helps subjects become familiar with their own taste sensitivity.  

- Preparation protocol 

Using the stock solutions prepared previously (Table 1), prepare a series of dilutions D1 to D8 of 
acidic and bitter flavours and an astringent sensation. 

- Implementing the test 

Prepare 10 glasses numbered 1 to 10 for each series for each subject. 

Series A: A1, A2, A3, A4, A5, A6, A7, A8, A9, A10  acidic 

Series B: B1, B2, B3, B4, B5, B6, B7, B8, B9, B10  bitter 

Series C: C1, C2, C3, C4, C5, C6, C7, C8, C9, C10  astringent 

Eight glasses correspond to dilutions D1 to D8 of the solution; one glass contains a repeat dilution 
and one glass contains water. The glasses are presented in increasing order of concentration, and 
the glass of water is served randomly. 

Serve the glasses in the order shown in Table 4 below (one line per series): 

TABLE 4: SERVING ORDER FOR PERCEPTION THRESHOLD TEST 
 
Series 1:                     
Glass A1 A2 A3 A4 AT 5 A6 A7 AT 8 A9 A10 

Order D1  D2  D3  D4  Water  D5  D5  D6  D7  D8  

Response Acidic 
 
Series 2:                     
Glass B1 B2 B3 B4 B5 B6 B7 B8 B9 B10 

Order D1  D2  D3  D4  D5  Water  D6  D6  D7  D8  

Response Bitter 



  Page 11 of 54 

 
Series 3:                     
Glass C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 

Order D1  D2  D3  D4  D4  Water D5 D6 D7  D8  

Response Astringent 

- Instructions 

Subjects must taste the solutions in the order they are presented in without backtracking. 

For each series, subjects must: 

- Determine from which dilution they perceive a flavour or sensation. 

- Determine how much dilution they can identify. 

- Determine which glass contains the repeat dilution. 

- Determine which glass contains water. 

On the form Perception Threshold of Basic Flavours and / or Sensations (see Appendix 5), 
subjects rate the following for each series: 

- 0: No perception (like water) 

- X: perception without identifying the flavour or sensation 

- XX: perception and identifies the flavour or sensation 

- XXX, XXXX, etc.: perception of increasing intensity (the more the perception becomes 
intense, the more crosses there are). 

Note: for the repeat dilution, record the same number of crosses. 

When all the panellists have taken the test, the facilitator performs a common correction. 

Triangular test 

A triangular test is carried out to test the ability of candidates to discriminate. 

This test can be performed on pure fruit juice purchased commercially. 

- Preparation protocol 

Prepare a drink of 10% diluted fruit juice using a pure fruit juice. 

- Implementing the test 

Prepare three solutions with the codes TUE, VVR and LNK as indicated in Table 5 below: 
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TABLE 5: CODING AND PREPARATION TRIANGULAR TEST 

 
TUE Solution 1: Pure drink 

VVR Solution 2: Pure drink 

LNK Solution 3: 10% diluted drink 

Fill and serve the glasses in the following order: 

 Panellist 1: TUE VVR LNK 
 Panellist 2: TUE LNK VVR 
 Panellist 3: VVR TUE LNK 
 Panellist 4: VVR LNK TUE 
 Panellist 5: LNK TUE VVR 
 Panellist 6: LNK VVR TUE 
 Etc. 

- Instructions 

Subjects must smell and taste the samples and determine which one they perceive as being 
different. 

Each panellist indicates his or her results on the Triangular Test form (see Appendix 6). 

When all the panellists have completed the test, the facilitator performs a common correction. 

The outcome of this test gives an indication of each panellist’s ability to discriminate. This will be 
assessed during the matrices training (see Part 2 – Tutorial: How to Process Data in Sensory 
Analyses). 

Smell recognition test 

The panel's training also includes an olfactory test. 

The aims of this test are to teach subjects how to assess and identify smells; to teach them to use 
the appropriate vocabulary; and to improve their individual abilities. 

Feeling and identifying smells makes it easier to memorise them; panellists will then be able to 
detect them better in a matrix.  

- Implementing the test 

The test is carried out with four different smells from natural products bought in a shop / market. 

Put the products in opaque glass bottles as shown in Table 6 below.  



  Page 13 of 54 

TABLE 6: SERVING ORDER FOR BOTTLES OF SMELLS 

 
A Citrus 

B Soil 

C Fruit 

D Spice 

- Instructions 

The panellists must identify the smell in each bottle by indicating its name or corresponding family 
(e.g. apple or fruit family, pepper or spice family, etc.). 

Each panellist indicates his or results on the Smell Recognition Test form (see Appendix 7). 

When all the panellists have finished the test, a joint correction is carried out by the facilitator. 

Subjects who undertake these tests must not have performed other sensory tests on detecting or 
assessing smells or odorous compounds at least 20 minutes prior to the trial. 

Describing a fruit puree 

The aim of this exercise is to check whether the subjects have an objective opinion about the 
product presented to them. 

- Implementing the test 

Each subject is served a plate containing ~ 30 g of fruit puree. 

- Instructions 

Subjects are asked to describe the fruit puree in their own words. They must give the descriptors 
that come to mind for the following categories: visual, smells, texture in the mouth, flavours, 
sensations and aromas. 

At the end of the session, a round table is held with everyone who was present at the session to 
discuss the vocabulary and to highlight the most relevant descriptors together. 

We will then be able to assess the ability of the subjects to describe a product, their verbal 
creativity and their ability to explain terms. 

1.2.3 Processing data from the general training  

Basic flavour recognition and sensation test 

If a panellist makes at least six mistakes out of the 12 answers (flavours, sensation, water) on this 
first test, they must leave the panel. 
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Basic flavours classification test and threshold test for perception of basic flavours 
and sensations 

If a panellist makes at least two mistakes on the five flavours and sensation to be identified when 
performing these two tests, he or she must retake Test 1 on recognising basic flavours and 
sensations. 

Smell recognition test 

If a panellist identifies a maximum of only one smell on this test, he or she must leave the panel. 

Outcomes 

If a candidate is selected, he or she joins the tasting panel. The "administrative" part is then put in 
place (see Appendix 8: Terms of Appointment and Confidentiality). He or she will subsequently be 
invited to carry out the matrix training tests. Every panellist who is authorised to remain on the 
tasting panel will take this general training once a year. 

When a candidate is not selected, he or she will be able to retake the selection tests in the future. 

Feedback is given to tasters in all cases. 

When a panellist decides that he or she no longer wants to be part of the tasting panel for any 
reason, a written request (by email or post) must be sent to the head of the sensory analysis 
laboratory. 

The head of the laboratory may terminate a panellist’s contract if he or she does not undertake any 
tasting sessions for a period of two years. 

1.3 Matrix Training 
- Tasting conditions 

Tastings must be carried out in specially designed rooms with individual testing booths. The 
atmosphere of the room must be controlled (light, smell, temperature, humidity and noise 
pollution), and any anomaly must be noted. 

A glass of water should be made available to all panellists so they can rinse their mouth between 
the different samples. 

- Types of rating scale 

Different types of scale may be used in sensory analysis. In the context of this project, a graded 
scale from 0 to 10 (using only whole numbers) should be used by each taster to record the 
intensity of each descriptor. 

1.3.1 Session 1: Generating a vocabulary 

The products are analysed using sensory descriptors that can be acquired via two methods: a pre-
established list that is available in the literature or the autonomous generation of descriptors. If the 
descriptors are not available in the bibliography, a group of qualified subjects must generate them. 
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Contrasting samples (e.g. 3-5) of the product to be tasted are presented. Coded A, B, C etc., they 
are served in the same order to all the panellists to facilitate discussion. 

The entire panel that has been selected and passed the general training is brought together for the 
study and presented with the products. Each panellist must independently and qualitatively 
generate a list of one-dimensional descriptors for all the products presented. 

Subjects are asked to use their own words to describe the product that is presented to them. They 
must give the descriptors that come to mind for the different categories – visual, smells, texture, 
flavours, sensations and aromas – and write them on a blank sheet of paper. 

The group will then work by consensus to select the most relevant and most commonly-stated 
descriptors; to group together synonyms and antonyms; and to eliminate hedonic, irrelevant or 
quantitative terms. 

The terms selected are the descriptors which, after the sorting-out process described above, have 
been validated by over 70% of the panel. 

A maximum of 20 descriptors should be selected. 

1.3.2 Session 2: Drawing up the tasting form 

The aim of this session is to draw up the tasting form (see Appendix 10: Tasting Form) with the 
definitions, assessment protocol and rating scale (limits and intermediates) for the three to five 
products previously contrasted. 

Each descriptor must be defined according to a precise method of characterisation. A table then 
has to be drawn up with the selected jury that includes the definition and assessment protocol for 
each descriptor as well as the limits for a scale that has been chosen previously (see Appendix 11: 
Assessment Protocol and Definition). 

A list of definitions based on ISO standard NF 5492-2009 is provided in Appendix 12 to help 
facilitators implement the tasting form. 

1.3.3 Session 3: Using the scale 

Examples of three or four benchmark products will be presented to the panel members so they can 
self-calibrate according to the limits of the rating scale.  

Panellists are asked to rate the descriptors used in the previous session by applying the agreed 
protocol. 

A joint discussion and correction is carried out by the facilitator. 

1.3.4 Session 4: Individual notation on the scale 

For the same three or four representative reference products, the panellists are asked to rate the 
descriptors individually on the selected tasting form. 

When all the panellists have taken the test, a joint discussion and correction is led by the facilitator 
in order to recalibrate the panellists who were not able to situate themselves on the scale. 
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1.3.5 Session 5: Panel performance 

The same test is carried out twice, when it will be possible to assess the performance of the panel 
on the basis of three criteria: repeatability, agreement with the panel and discrimination. 

The assessment of the panel's performances will be carried out as indicated in Part 2: Tutorial: 
How to Process Data in Sensory Analyses. 

1.4 Implementing the Test 
A product-specific protocol must be drawn up to perform the test. There is no particular protocol 
and, depending on your product, you will need to decide on the protocol that will be implemented 
based on the following: 

- The methods for preparing the sample (cooking time and temperature, cutting up the sample to 
be served, its homogeneity, etc.) 

- The variable maturation of the sample (tasting day, etc.) 

- Ease of service (samples served one-by-one or all together, etc.) 

- The tasting temperature (cooling the sample, for example, is known to harden the pulp of cooked 
products) 

- The maximum number of products presented per session (a maximum of four is recommended) 

- The number of repetitions (on the same day or on different days or no repetition of tasting, etc.) 

Defining these criteria determines the order in which the samples are presented, the number of 
samples presented per session, the way they are served, and the number of repetitions on the 
same day or over several days. 

The products to be analysed must in all cases be offered to the tasters anonymously. They should 
be identified by a three-digit or three-letter code and served in random order. 

Appendix 9 shows an example of a tasting by each panellist of four products prepared, served and 
tasted randomly. 

The codes given in Appendix 9 should not be used for more than one session. Each pair of 
samples / repetitions corresponds to a random code and must be tasted in a specific, 
predetermined order. 
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1.5 Appendices 
1.5.1 Annex 1 
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1.5.2 Annex 2 
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1.5.3 Annex 3 
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1.5.4 Annex 4 
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1.5.5 Annex 5 
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1.5.6 Annex 6 
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1.5.7 Annex 7 
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1.5.8 Annex 8 
 
 

 



  Page 25 of 54 

1.5.9 Annex 9 
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1.5.10 Annex 10 
 

Matooke
Date: Name :

Sample 1 Sample 2 Sample 3
Yellow

Homogeneity of 
colour

Firmness

Moisture

Smoothness

hardness

Moldability

Stickiness

Sweetness

Sourness

Impression Astringency

Matooke

Pumpkin

Grassy

Aroma

Appearence

Texture in mouth

Texture by touch

Taste
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1.5.11 Annex 11 
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1.5.12 Annex 12: Vocabulary – Sensory analysis 

- acidity / acid taste 

basic taste produced by dilute aqueous solutions of most acid substances (e.g. citric acid and 
tartaric acid) 

- sourness / sour taste 

Basic taste, gustatory complex sensation, generally due to presence of organic acids 

- bitterness / bitter taste 

basic taste produced by dilute aqueous solutions of various substances such as quinine or 
caffeine 

- saltiness / salty taste 

basic taste produced by dilute aqueous solutions of various substances such as sodium 
chloride 

- sweetness / sweet taste 

basic taste produced by dilute aqueous solutions of natural or artificial substances such as 
sucrose or aspartame 

- astringent 

Impression / complex sensation, accompanied by shrinking, drawing or puckering of the skin or 
mucosal surface in the mouth, produced by substances such as kaki tannins or sloe tannins 

- body 

consistency, compactness of texture, fullness, richness, flavour or substance of a product 

- transparent 

allowing light to pass and distinct images to appear 

- opaque 

not allowing the passage of light 

- glossy / shiny 

a shiny or lustrous appearance resulting from the tendency of a surface to reflect light energy 
at one angle more than at others 

- texture 

“in the mouth” all of the mechanical, geometrical, surface and body attributes of a product 
perceptible by means of kinaesthesis and somesthesis receptors and (where appropriate) 
visual and auditory receptors from the first bite to final swallowing 
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NOTE 1 Over the course of mastication, perception is influenced by the physical 
transformations that occur from contact with the teeth and palate and mixture with saliva. 

Auditory information may contribute to judgement of texture and may predominate with dry 
products. 

NOTE 2 The “mechanical attributes” are those related to the reaction of the product to stress. 
They are: hardness, cohesiveness, viscosity, elasticity and adhesiveness. 

The “geometrical attributes” are those related to the size, shape and arrangement of particles 
within a product. They are: denseness, granularity and conformation. 

The “surface attributes” are those related to the sensations produced in the mouth by moisture 
and/or fat in and near the surface of the product. 

The “body attributes” are those related to the sensations produced in the mouth by moisture 
and/or fat in the substance of the product and the way in which these constituents are 
released. 

- hardness 

mechanical textural attribute relating to the force required to achieve a given deformation, 
penetration, or breakage of a product 

NOTE 1 In the mouth, it is perceived by compressing the product between the teeth (solids) or 
between the tongue and palate (semi- solids). 

NOTE 2 The main adjectives corresponding to different levels of hardness are: 

— “soft”: low level, e.g. cream cheese; 
— “firm”: moderate level, e.g. olive; 
— “hard”: high level, e.g. boiled sweets. 

- cohesiveness 

mechanical textural attribute relating to the degree to which a substance can be deformed 
before it breaks, including the properties of fracturability, chewiness and gumminess 

- fracturability 

mechanical textural attribute related to cohesiveness and hardness and to the force    
necessary to break a product into crumbs or pieces 

NOTE 1 It is evaluated by suddenly squeezing a product between the incisors (front teeth) or 
fingers. 

NOTE 2 The main adjectives corresponding to different levels of fracturability are: 

— “cohesive”: very low level, e.g. caramel, chewing gum; 
— “crumbly”: low level, e.g. corn muffin, cake; 
— “crunchy”: moderate level, e.g. apple, raw carrot; 
— “brittle”: high level, e.g. peanut brittle, brandy snaps; 
— “crispy”: high level, e.g. potato crisps/chips, cornflakes; 
— “crusty”: high level, e.g. crust of fresh French-style bread; 
— “pulverulent”: very high level, immediately disintegrating into powder upon biting, e.g. 
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overcooked egg yolk. 

- chewiness 

mechanical textural attribute related to the amount of work required to masticate a solid 
product into a state ready for swallowing 

NOTE The main adjectives corresponding to different levels of chewiness are: 

— “melting”: very low level, e.g. ice cream; 
— “tender”: low level, e.g. young peas; 
— “chewy”: moderate level,  e.g. fruit gums (confectionery); 
— “tough”: high level, e.g. old beef, bacon rind. 

- gumminess 

mechanical textural attribute related to the cohesiveness of a tender product 

NOTE 1   In the mouth, it is related to the effort required to disintegrate the product to the state 
ready for swallowing. 

NOTE 2 The main adjectives corresponding to different levels of gumminess are: 

— “short”: low level,  e.g. shortbread; 
— “mealy”: moderate level, e.g. some potatoes, cooked dry haricot beans; 
— “pasty”: moderate level, e.g. chestnut puree, flour paste; 
— “gummy”: high level, e.g. overcooked oatmeal, edible gelatine. 

- viscosity 

mechanical textural attribute relating to resistance to flow 

NOTE 1 It corresponds to the force required to draw a liquid from a spoon over the tongue, or 
to spread it over a substrate. 

NOTE 2 The main adjectives corresponding to different levels of viscosity are: 

— “fluid”: low level, e.g. water; 
— “thin”: moderate level, e.g. olive oil; 
— “unctuous” or “creamy”: moderate level, e.g. double cream, heavy cream; 
— “thick”  or  “viscous”:  very   high, 

e.g. sweetened condensed milk, honey. 

- consistency 

mechanical attribute detected by stimulation of the tactile or visual receptors 

- elasticity / springiness / resilience 

mechanical textural attribute relating to: the rapidity of recovery from a deforming force; and 
the degree to which a deformed material returns to its original condition after the deforming 
force is removed 

NOTE The main adjectives corresponding to different levels of springiness are: 
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— “plastic”: absence, e.g. margarine; 
— “malleable”: moderate level, e.g. marshmallow; 
— “elastic”; “springy”; “rubbery”: high level, e.g. cooked squid, clams, gums. 

- adhesiveness 

mechanical textural attribute relating to the force required to remove material that sticks to 
the mouth or to a substrate 

NOTE 1 The main adjectives corresponding to different levels of adhesiveness are: 

— “tacky”: low level, e.g. marshmallow; 
— “clinging”: moderate level, e.g. peanut butter; 
— “gooey”, “gluey”: high level, e.g. caramel sundae topping, overcooked rice; 
— “sticky”, “adhesive”: very high level, e.g. toffee. 

NOTE 2 The adhesiveness of a product may be experienced in various ways, e.g. 

— to palate — force required to remove product completely from the palate, using the  
tongue, after complete compression of the sample between tongue and palate; 

— to lips — degree to which the product sticks/adheres to  the lips — the sample is placed 
between the lips, compressed once slightly and released to assess adhesiveness; 

— to teeth — amount of product adhering on/in the teeth after product mastication; 
— to itself — force required to separate individual pieces with the tongue, when the sample is 

placed in the mouth; 
— manually — force required to separate individual pieces adhering to each other using the 

back of a spoon. 

- denseness 

geometrical textural attribute relating to perception of the compactness of a cross-section of a 
product after biting completely through it 

NOTE The main adjectives corresponding to different levels of denseness are as follows: 

— “light”: low, e.g. whipped topping; 
— “heavy”, “dense”: high, e.g. chestnut cream, traditional English-style Christmas pudding. 

- granularity 

geometrical textural attribute relating to the perception of the size, shape and amount of 
particles in a product 

NOTE The main adjectives corresponding to different levels of granularity are as follows: 

— “smooth”,   “powdery”:  absence, 

e.g. icing sugar, dry cornflour; 

— “gritty”: low level, e.g. some pears; 
— “grainy”: moderate level, e.g. semolina; 
— “beady”: having small, spherical particles, e.g. tapioca pudding; 
— “granular”: having angular, hard particles, e.g. demerara sugar; 
— “coarse”: high level, e.g. cooked rolled oatmeal; 
— “lumpy”: high level with larger, irregular particles, e.g. cottage cheese. 
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- conformation 

geometrical textural attribute relating to the perception of the shape and the orientation of 
particles in a product 

NOTE The main adjectives corresponding to different conformations are as follows: 

— “cellular”: spherical or ovoid particles consisting of thin walls surrounding liquid or gas, e.g. 
orange; 

— “crystalline”: angular, similarly sized, symmetrical, three- dimensional particles, e.g. 
granulated sugar; 

— “fibrous”: long particles or strands oriented in the same direction, e.g. celery; 
— “flaky”: loose layers that separate easily, e.g. cooked tuna, croissant, flaky pastry; 
— “puffy”: hard or firm outer shells filled with large, often uneven, air pockets, e.g. cream puff, 

puffed rice. 

- moisture 

surface textural attribute that describes the perception of water absorbed by or released from a 
product 

NOTE The main adjectives corresponding to different levels of moistness are as follows: 

Surface attributes: 

— “dry”: absence, e.g. cream cracker; 
— “moist”: moderate level, e.g. peeled apple; 
— “wet”: high level, e.g. water chestnut, oyster. 

Body attributes: 

— “dry”: absence, e.g. cream cracker; 
— “moist”: moderate level, e.g. apple; 
— “juicy”: high level, e.g. orange; 
— “succulent”:  high level, e.g. meat; 
— “watery”:   water-like perception, 

e.g. watermelon. 

- fattiness 

textural attribute relating to the perception of the quantity or the quality of fat on the surface or 
in the body of a product 

NOTE The main adjectives corresponding to the perception of fattiness are as follows: 

— “oily”: perception of soaking and running fat, e.g. salad with dressing; 
— “greasy”: perception of exuding fat, e.g. bacon, chips, French fries; 
— “fatty”: perception of high fat proportion in a product, oily, greasy, e.g. lard, tallow. 
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2 PART 2: TUTORIAL: HOW TO PROCESS DATA IN 
SENSORY ANALYSIS 

Aim: To Assess the Performance of the Panel 

2.1 Assessing the Panel's Performance 
Subjects in a quantitative descriptive analysis test should not issue judgments based on their 
preferences. They should only characterise products according to their sensory perception, as 
though it were an instrument of measurement. 

As with any other measuring device, it is important that the data produced is reliable. It follows that 
measuring the performance of a panel and its panellists is a key issue in sensory analysis. In 
practical terms, performance is viewed from two perspectives: the individual performance of the 
panellists and the performance of the panel as a whole. 

The notion of performance, which is widely discussed in the literature, is usually divided into three 
concepts: repeatability, agreement and discrimination between the panellists (ISO 8586-1, 1993). 

These three performance-related concepts will be addressed here from a so-called one-
dimensional angle: one sensory descriptor at a time. The goal will be to obtain detailed information 
on panel performance for each sensory descriptor. 

2.1.1 Definitions 

Repeatability 

When repeatedly presenting the same stimulus, the measurements must be as close as possible 
to each another. In sensory analysis, the accuracy of the measurement is also called the 
repeatability. 

We say that the repeatability is effective if the deviation between two observations is less 
than or equal to 2 on a rating scale of 0 to 10. 

Illustration of the concept of repeatability for a product assessed by a panellist (A)  

 

Agreement 

Agreement between the panellists measures the homogeneity of the responses obtained for the 
same stimulus by the different tasters. This characteristic results from the fact that the panel, unlike 
the majority of "standard" measurement tools, consists of several sub-units of independent 
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measurements: the panellists. Agreement denotes the overlapping of the scores given by the 
panellist for identical products. 

Illustration of the concept of agreement for a product assessed twice by a panellist (A) and the 
panel (the shaded ellipse represents the average of the scores ± standard deviation). 

 

We say that the agreement is effective if 70% of the deviation (absolute value) between the 
average of the panel and the average of the panellist (for an identical product assessed 
twice) is lower than the standard deviation of the panel. 

In the example above,  

First case: effective agreement 

Absolute value [70% x (3.5α – 4.5β)] = 0.7, i.e. < 2.5π (α panel average, β panellist average, π panel 
standard deviation) 

Second case: Ineffective agreement 

Absolute value [70% x (6.0α – 2.0β)] = 4.0, i.e. > 2.0π (α panel average, β panellist average, π panel 
standard deviation) 

Discrimination 

Discrimination is the ability to detect a difference in intensity between two or more two samples 
for a given descriptor. It indicates whether panellists were able to differentiate the products in the 
study or not. 

Discrimination is related to the notion of repeatability since it becomes more difficult to be 
discriminating when the level of repeatability is low. But it is also possible for a panellist who is less 
repeatable than another to be more discriminating. Typically, someone for whom all the scores 
given were 0 is highly repeatable but not at all discriminating, whereas a person who is not very 
repeatable but who uses the full scale to make his or her scores may be discriminating. 

Illustration of the concept of discrimination for two products (A and B) assessed twice by a 
panellist. 
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The ability to discriminate for a given descriptor is generally assessed by means of the product 
effect of an analysis of variance model. The product F values and the p-values associated with 
the product effect reflect the ability to discriminate.  

Note: The product F values are preferred to those of the p-values because they allow panellists to 
be sorted by decreasing performance even for a limited number of observations (which is often our 
case). The p-value will be used only to assess the ability of the panel (in its entirety) to 
discriminate. 

2.1.2 Using Excel to assess the performance (repeatability and 
agreement) of a panel 

In this section, we will see how to assess the performance of a panel using Excel based on an 
example. In this example, the panel consists of eight panellists; three products (A, B, C) are tasted 
twice; and 10 sensory attributes were chosen based on previous sessions (vocabulary generation 
and use of the rating scale). 

Entering the raw data  

Open the Excel file assessment of repeatability and agreement_initial data.xls. 

1. In the Sample tab, enter the data for the samples to be tasted. 
Variety Sample code Repetition Tasting code 
Hybrid 201 A 1 A1 
Hybrid 201 A 2 A2 
Fougamou B 1 B1 
Fougamou B 2 B2 
Ney Poovan C 1 C1 
Ney Poovan C 2 C2 

2. In the Panel tab, enter the data about the panellists (last name, first name, panellist code). 
3. In the Data tab, enter the results of the tasting sessions. 

• Note the attributes from cell E1. In the example, the attributes are D1 to D10. 
• Enter the scores given by each panellist for each product at each session. At this stage, the 
order you enter the data by panellist, product and session is not important. In the example, the 
data was entered randomly.  
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Sorting the raw data 

Raw data should be sorted by product and panellist:  

1. Open a new tab. 

  

A new tab Sheet1 appears. 

2. Select all the data in the table in the Data tab and copy and paste in the Form1 tab. 
3. Select all the data in the table in the Sheet1 tab, then go to the sorting tools: click on Data (1) 
followed by Sort (2) and Add level (3), then display Sample code (4) before displaying Panellist (5) 
then OK (6).  

Click here 
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View the panel’s descriptive statistics 

The panel’s descriptive statistics must be calculated by product and for each descriptor: the 
average, standard deviation, minimum and maximum: 

1. Insert 6 lines after each product (A, B, C): select lines 18 to 23 (1) and click on Insert (2). 
Repeat for lines 40 to 45. 

2 
 

1 

3 

4 

5 
6 
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2. Calculate the average, standard deviation, minimum, maximum and deviation (max – min) 
for product A and the D1 descriptor: 
• In cell E18, enter "=average(E2:E17)" 
• In cell E19, enter "standarddeviation(E2:E17)" 
• In cell E20, enter "min(E2:E17)"  
• In cell E21, enter "max(E2:E17)" 
• In cell E22, enter "E21-E20" 

3. Copy and paste the cell range (E18:E22) for all the descriptors (F18:N22) for product A. 
4. Copy and paste the cell range (D18:N22) for product B (D40:N44) and product C 
(D62:N66). 

1 

2 
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5. The contents of the Sheet1 tab must be similar in presentation to those of the Sorting data tab 
that was used for the example (here eight panellists, three products tasted twice and 10 attributes). 
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View the performances of the first panellist 

The aim here is to display the repeatability and agreement results for panellist 1. The data for 
product A is first retrieved: 

1. Copy (Ctrl-C) the cell range (A2:N3) in the Sheet1 tab (or Sorting data) and paste (Ctrl-V) this 
range into the Performance panelist1 tab in cell A2. 
2. Copy the cell range (E18:N19) in the Sheet1 tab and paste the values (1) in this range into the 
Performance panelist1 tab in cell E7. 
3. Copy the cell range (E20:N22) in the Sheet1 tab and paste the values in this range into the 
Performance panelist1 tab in cell E11. 

  

4. Repeat steps 1 to 3 for products B and C. 

Reading and interpreting the results of the performance of the first panellist 

Let's look at the results shown in Table 1 (C44:N49) and 2 (C74:N75).  

1. Table 1 shows whether the panellist was repeatable and in agreement with the panel for 
each product and descriptor. 

 

1 
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Table 2 indicates whether the panellist was repeatable and in agreement with the panel for all 
products and for each descriptor. 

• The panellist is considered repeatable for a descriptor if he or she was repeatable for over 
50% of the products tasted, i.e. here for at least two of the three products. 
• The panellist is considered in agreement with the panel for a descriptor if he or she was in 
agreement with the panel for over 50% of the tasted products, i.e. here for at least two of the three 
products. 

 

Panellist 1 is repeatable for all the sensory attributes except D7 and D8, and is in agreement with 
the panel for all the attributes except D3. 

3. Charts A, B and C show the results of panellist 1 in relation to the panel for each product 
and descriptor: in red is the average of the scores of the two repetitions (for products A, B or C) for 
panellist 1; in black is the average of the scores of the two repetitions for the panel; and in yellow is 
the range of the scores of all the panellists (maximum – minimum).  

 

Show the performances of all panellists 

The goal is to display one tab per panellist: 
1. On the Performance panellist 1 tab, right click then click on Move or Copy (1)  



  Page 42 of 54 

 

2.  A window appears: click on (move to end) (2) then tick Create a copy (3) and OK. 

 

3. Rename the tab: double click left on the Performance Panellist 1 (2) tab and modify 
Performance Panellist 2. 
4. Copy the cell range (A4:N5) in Sheet1 (or Sorting data) tab and paste this range into the 
Performance Panellist 2 tab in cell A2. Repeat for products B and C. The performance results for 
panellist 2 are now ready. 
5. Repeat steps 1 to 4 as many times as there are panellists. 

A summary table gathering the performances of all the panellists is proposed: 

6. Open a new tab called Panel. 
7. Copy and paste the values from Table 2 for each panellist into this tab. 
8. Sort them from the first column. You will obtain the following table: 

1 
 
 

3 
 
 

2 
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9. Calculate the number of "Yes" responses per panellist and performance criterion: in cell L2, 
enter =NB.SI.ENS(B2:K2;"yes"); copy and paste this cell into the cell range (L3:L9) and (L11:L18).  
10. You will obtain the following summary table available in a new file: assessment of 
repeatability and agreement_final data.xls. 
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2.1.3 Assessing a panel’s ability to discriminate using XLSTAT 

We are going to assess a panel’s discrimination ability by calculating the product F values 
associated with the product effect of an analysis of variance model. The software used here to 
calculate the product F values is XLSTAT, but any other statistical software is valid. 

Prepare the data tables for the variance analysis 

1. Open the Excel file assessment of discrimination_initial data.xls. 
2. Open a new tab Sheet1 (see Section 22). 
3. Select all the data from the table in the Data tab and copy and paste in the Sheet1 tab. 
4. Sort the data from the Panellist column (see Section 22). 
5. Insert a line above each panellist and copy and paste the line of variable labels. 

The final tab, renamed Sorting data, must be in this form: 
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Perform ANOVAs for the panel as a whole 

1. Open XLSTAT, then Data modelling followed by ANOVA. A new window appears. 
2. In the General tab, select the range of cells (E1:N49) for quantitative dependent variables 
(1). 
3. Select the cell range (C1: C49) for qualitative explanatory variables (2). 
4. Tick Variable labels (3). 

 

1 
 
 

2 
 
 

3 
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5. In the Outputs tab, tick only Descriptive statistics and Analysis of variance. 

 

6. In the Charts tab, tick only Summary charts and then OK. 

 

7. In the new sheet called ANOVA, a summary table is displayed for the analysis of variance 
for all the descriptors at the end of the results (L535:540). 
8. Rename cell Pr>F with Panel discrimination. 

 

9. Copy and paste the lines of the variable label and Panel discrimination into a new sheet 
called product F. Note that only the descriptor D5 could not be discriminated by the panel (p-value 
> 0.05). 
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Performing ANOVAs for each panellist 

Start with Panellist No. 1. 

1. Go to the Sorting data sheet. 
2. Open XLSTAT, then Data modelling followed by ANOVA. A new window appears. 
3. In the General tab, select the range of cells (E1:N7) for Quantitative dependent variables.  
4. Select the cell range (C1:C7) for Qualitative explanatory variables. 
5. Select the range of cells (B1:B7) for Comments labels.  
6. Tick variables labels. 
7. In the Outputs tab, tick only Descriptive statistics and Analysis of variance. 
8. In the Charts tab, tick only Summary charts then OK. 
9. In the new sheet called ANOVA1, a summary table is displayed of the analysis of variance 
for all the descriptors at the end of the results (L536:541) 
10. Rename cell F Discrimination J1. 

 

11. Copy and paste the line F panellist 1 in product F.  
12. Perform ANOVAs for all the other panellists by repeating steps 1 to 11. 
13. The summary table showing all the values of F is in this form. 

 

14. Calculate the median for each panellist: in cell L3 enter '=median(B3:K3); copy and paste 
this cell into the cell range (L4:L10). 
15. All the results are available in the file assessment of discrimination final data.xls. 

Interpreting the results:  

• The panel as a whole is capable of differentiating the three products except for the D5 
attribute (p-value > 0.05). Either the three products were not sufficiently different for this attribute or 
the panellists did not understand the meaning of this attribute. A special tasting session on this 
attribute may be carried out if deemed relevant. 
• In terms of the panellists, the higher the product F value, the more the panellist is able to 
discriminate the products for such an attribute. There is no threshold value for deciding whether a 
panellist is able to discriminate or not. In the example, calculating the median makes it possible to 
sort the panellists by decreasing performance according to their median F. It turns out that panellist 
No. 8 is the top performer and panellist No. 7 the lowest. 
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2.1.4 Decision rules 

Let's merge the final tables of the panellists’ performances (Sections 28 and 33). 

Suppose we obtain the following results: 

 

Sort the panellists by level of performance 

Let's sort the panellists according to each performance criterion from the highest to lowest: 

1. Sort the first two tables Agreement and Repeatability on the basis of the number of Yes 
responses. 
2. Sort the Discrimination table based on the median. 
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3. The panellists at the bottom of the table are the worst performers. 

Decision and recommendation rules 

1. A panellist performs well in terms of repeatability if he or she is repeatable for at 
least 70% of the descriptors. In the example given, he or she must have at least seven yes 
responses for the 10 descriptors. In the opposite case (at least four no responses), he or she is 
asked to take a new training session with three new products (identical or not to those of the 
previous sessions) that are repeated once. 

• In the example above, panellist No. 1 will be assessed during a new session; he or she will be 
informed in advance of the difficulties he or she has encountered in terms of repeatability for 
attributes 3, 5, 7 and 8. 

2. A panellist performs well in terms of agreement with the panel if he or she is in 
agreement for at least 70% of the descriptors. In the example given, he or she must have at 
least seven yes responses. In the opposite case (at least 4 no responses), he or she is asked to 
take a new training session repeated once with identical products to the previous ones. 

• In the example above, panellist No. 4 will be assessed during a new session; he or she will 
be informed in advance of the difficulties he or she encountered in terms of agreement with the 
panel for attributes 2, 4, 6, 8 and 9. 

3. We have not set any rules for the discrimination criterion. However, we recommend that the 
panel facilitator talks with panellists who have difficulties in discriminating products about the use of 
the rating scale, specifically about the attributes that may have been discriminated by the panel. 
• In the example above, the panel facilitator will meet panellist No. 7 and talk to him or her 
about the ability to use the entire rating scale. 
• As the panel was not able to discriminate attribute 5, the individual performances of the 
panellists are not challenged. 

2.2 Basic Charts from a QDA / Descriptive Test 
The aim here is to provide basic charts using the results from the final tasting test (see Section 4, 
Part 1): radar and bar chart. 

Take the example given in the radar.xls Excel file. In this example, six products were tasted by 
eight panellists. 

2.2.1 Preparing the final data table 

1. Open the Data tab 
2. Calculate the average for products A to F: 
• In cell D52, enter "=average(D2:D9)". 
• Do the same to calculate the average for the other products. 
• Copy and paste the cell range (D52:D57) for all the descriptors (E52:M57). 
• The following summary table is obtained: 
3. Copy and paste the range of cells (E18:E22) for all the descriptors (F18:N22). 
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2.2.2 Radar 

The radar can be used to quickly view and compare the sensory traits of the products according to 
the scores obtained by the panel for all the attributes. 

1. Select the cell range (C51: M57). 
2. In the Insert tab (1), look for the radar icon (2). 

 

 

1 
 
 

2 
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3. Enlarge the image as follows; add a title to the chart and increase the font size of the labels 
and captions. 
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2.2.3 Bar chart 

The bar chart can be used to view the differences in scores between the products by attribute. 

1. Select the cell range (C51:M57) 
2. In the Insert tab (1), look for the bar chart icon (2). In our Excel 2016 version, click on a 
small icon (3) to access the bar chart you want (2). 

  

1 
 
 

2 
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3. Enlarge the image as follows; add a title to the chart and increase the font size of the labels 
and captions. 
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